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Apple Push Notification Service
(APNSs)

What Is APNs

Apple Push Natification service (APNSs) is a highly secure and efficient system for communicating with i0OS
devices over-the-air (OTA). Each device establishes an accredited and encrypted IP connection with the
service. The provider, in this case your ZENworks Mobile Management server, connects with and sends its
notification to the APNs, which pushes the notification to the target device.

An APNSs certificate is required for Apple Push Notification service. The certificate must be renewed annually.
This guide explains the process of obtaining the APNs certificate from Apple and provides instructions on how
to upload the certificate to the ZENworks Mobile Management server via its dashboard.

There are various methods of generating the APNs certificate, any of which you may use. This document
guides you through generating the certificate by using Microsoft Windows Internet Information Services (11S)
Manager, version 6, 7, or 8.

How APNs Works

Apple Push Notification service works in conjunction with the built-in MDM protocol of Apple iOS devices.
ZENworks Mobile Management uses the Apple Push Notification service to send notifications to the iOS
device requesting information. Only notifications, not data, are sent through the APNs server. The device
responds directly to the ZENworks Mobile Management server.

The Apple MDM protocol provides the following functionality:
o Devices support Selective Wipe, Lock Device, and Clear Passcode
e Full Wipe and Lock Device commands are applied immediately
e You can record and access installed applications on devices
e You can record and access installed configuration profiles on devices
e You have access to additional device statistics
e Configuration profile updates require no user interaction
e Enterprise (in-house) apps
e Mobile App Management
e Manage VPP (Redemption) Codes
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Requirements

ZENworks Mobile Management version 2.5.2 or later

An Apple ID. We recommend that you do not use a personal Apple ID, but create a separate
corporate Apple ID for MDM. Associate the Apple ID with an email account that will remain with your
company — not an email account that belongs to an individual in the company. This facilitates a
smooth certificate renewal process each year.

Windows Server 2003, 2008, or 2012 (you need administrator permissions)

Firefox or Safari Web browser

An Overview of the Steps to Obtain the Apple Push Notification Service Certificate

1.

Create a Certificate Signing Request (CSR). (This guide provides instructions for creating the
certificate from Microsoft Windows Internet Information Services (lIS) Manager, version 6, 7, or 8. An
alternate method, using OpenSSL, is documented in Appendix A.)

Upload the CSR to the ZENworks Mobile Management Certificate Portal. Novell, Inc. signs the CSR.

Upload the intermediate certificate (the CSR signed by Novell, Inc.) to the Apple Push Certificates
Portal. Apple issues the certificate.

Download the signed certificate from the Apple Push Certificates Portal and complete the certificate
request in IIS.

Export the certificate to a file.

Upload the certificate to the ZENworks Mobile Management server.

Croate a Certificate Signing
Request (CSR) In US
The US server and the

ZENworks server can be the

required

Generating an Apple Push Notification Service Certificate for use with
ZENworks Mobile Management for iOS

5 5.

Export the certificate you just

created as a pix flle
Croato a password whilo

ame server, but this s not exporting

Use IS to complete the
certificate request

proce using the

certificate issued by
Apple

Management dashboard to upload
the APNs certificate to the ZENworks
server

Log in to the dashboard with the
external server address so that the
Use Default URLs option can be

tilized
"
Upload the signed Intermediate Certificate to
Upload the CSR to the ZENworks Certificats tho Apple Push Cortificates portal, Apple
portal to got it signed by Novell, A requess issues the certificate in a _pem flie
file is gonerated for Download this file
hitps.//zmmupdate novell convapn/ hitps Mdentity appie comipusheert
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Generating an APNs Certificate

Generating an APNs Certificate from Windows Server 2003

The following instructions are for generating an APNs certificate from a Windows Server 2003 by using
Internet Information Services (1IS) Manager version 6. You can skip this section if you use Windows Server
2008 or 2012. For Windows Server 2008 or 2012, see Generating an APNs Certificate from Windows Server
2008 or 2012.

Note: Appendix A provides instructions for an alternate method of generating the APNs certificate using
OpenSSL.

Creating the Certificate Signing Request (CSR) from IIS Manager 6

1. Select Start > Control Panel > Administrative Tools > Internet Information Services (lIS)
Manager.

2. Right-click any Web site in the left panel. Select Properties.

Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

Web Site | |ISAP| Fiters I Home Directary I Documents
Diectory Secunty | HTTP Headers | CusomEmors |  ASPNET

r Anorymous access and authertication control
I ; Enable anormymous access and edit the

authentication methods for this resource. Edit... |

- IF address and dommait hame restictions

[arant or deny azsess bojthis resauTce using

@ |F addiesses or intemet domain names.
Edit. . |
o

r Secure communications Y 4
Require secure communications and -
enable client certificates when this Server Carficats...
resource is accessed. ) .
Wiew Certificate.. |
Edit. . |

QK Cancel I Appl | Help |
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4. Select the Create a new certificate option and click Next.

5. Select Prepare the request now, but send it later option and click Next.

1S Certificate Wizard —
Server Centificate
Trere are five methods for assigning & cenificate 10 3 Web ate

Select the method you wart 10 use for this wab site:
* Create 3 new cenrficate.

(™ Assign an edsting cedificale

(" Import a canficate from 2 Kay Manager backup file.

Ddlayed or immediate Requeat

You can preoare a reques 10 be sant later. or you ¢an send cne
immediately.

Do you want to prepare 3 cetfficals reouest to be sent later or do yo
immadiately 1o an onlne cerdification athanity?
' Prepare the request now, but eena t later

C Serd Ve raquestmmetiately 15 a0 o4 7= cattitication ot

u

6. Enter a certificate name that is easily remembered. In the Bit length field, select 2048 for the
encryption level, then select Select cryptographic service provider (CSP) for this certificate. Click

7. From the Available Providers window, select Microsoft RSA SChannel Cryptographic Provider.

Next.
Click Next.

Mame and Security Settings
Your new certificate must have a name and a specific bit length.

Type a name for the new certificate, The name should be easy for you to refer to and
remember.

Mame:

The bit length of the encryption key determines the certificate's encryption strength,
The greater the bit length, the stronger the security. However, a greater bit length may
decrease performance.

Bit length: |2043 - l

[T Select cryptographic service provider [CSP) for this certificate

< Back I et > I Cancel

1S Certificate Wizard
Available Providers

The cryptographic provicers you can Lae for your ceaficats ave iked
below

Swleci a provider
Microgof: DH SChamnel Cryptoars:

Microaoft RSA SChannel Crypt
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8. Enter the legal name of your Organization and the Organization unit, which is the department

within your organization. Click Next.

9. Inthe Common name field, enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the corporate
APNs certificate. The Apple ID might be in the form of an email address, or possibly a display name.

Click Next.

IIS Certificate Wizard
Organization Information

‘r'our certificate must include information about your organization that
digtinguishes it from other organizations.

Select or type your organization's name and your arganizational unit. This is tpically the
legal name of pour organization and the name of your division or department.

Far further infarmation, consult certification authority's Web site.

Organization:

INoveII, Inc. j
Organizational unit:

fil =1

Cancel

< Back I Mest > I

IIS Cettificate Wizard

Your Site's Common Name
\?’

‘Your Web site's common name is its fully qualified domain name.

Type the common name for your site. If the server is on the Intemet, use a valid DNS
name. |f the server is on the intranet, you may prefer to use the computer's NetBIOS
name.

If the common name changes, you will need to obtain a new certificate.

LCommon hame:
My &pplelD|

< Back | Hext> I

Cancel

10. Enter the Country/Region, State/Province, and City/locality of your organization. Click Next.

In the Certificate Request File Name window, save the CSR to your computer. Record the location
and filename. This is the file you will upload to the ZENworks Mobile Management Certificate

Request Portal. Click Next.

IIS Certificate Yizard
Geographical Information
The certification authority requires the following geographical information.

LCountry/Region:
IUS [United States) Vl

State/province:

IUtah j
Citydlacality:

IF'rovd j
State/pravince and City/locality must be complete. official names and may nat contain
abbreviations.

Cancel

< Back I Mest » I

Yot V—
v 3

Uertiticale Hequest Hic Name
Your codifizate megoes = saved as a e fe i the file neme yo
specity

Enter a file name for the ceddrficate regscat.

Iie name
f- \AppleMCH_CER 1

m

11. Review the information for the certificate request in the Request File Summary window. To make
revisions, click the Back button. Click Next to accept, then click Finish.
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated through IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You will need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at
https://zmmupdate.novell.com/apn

&7 Novell.

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

(Browse... |

Get Signed Request ]

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/

2. Log in by using your Apple ID and password. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNSs certificate.
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https://zmmupdate.novell.com/apn
https://identity.apple.com/pushcert/

Apple Push Certificates Portal
Sign n.

Forgot your Aapie 107

ForQot your password?
S m
Mg Agpbe Ovline 3enre {7 -30-MY - AT G * wh Mgk Batail Stove Soedd w reanliee Adshle (e Sow Map HEE v A5 Pty Coenact Uy e
Acsh AL reghes reemrewd . Tarws sf Use Provery Pubes

3. Select Create a Certificate.

Apple Push Certificates Portal eres =

Get Started

Create a push cartificate that enables your third-party servar 10 work with the Apple Push
Notification Service and your Apple devices,

(CRR S
FAQ

SAIN MOre About Mol Device Managerment
Whaat About QS X Server

W Apahe Onling bonee B0-NT - arv Ak bl Stase Had 4 romalie

Apple 1nt. AN s rebeisnd  Tarmes 3f Use Prrinsy Paliey

4. Read the Terms of Use and accept the End User License Agreement.
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iMhone

Apple Push Certificates Portal

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONOITIONS CAREFULLY BEFORE
DOWRLOADING DR USING THE APPLE CERTIFICATE §, THE SE TERMS AND COMINTIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANYORGANIZATION AND APFLE,

MOM Cavtficate Agteament
(Tor companies deploying modile davce Tor 105 pr

Purpose

Your company, srganizatan of educationsl Fstikaion woukd 16s & use he MOR Catiicates (35 detned
Balow] 10 enstle You to ether deploy 3 thd-party Commercisl, sctarpriss sener software peoduct fot nobile
device managament of I0S procucts, of deploy Your own intamal mobde dedce management 1or 108
prodhucts withieh Yaur compiany, onganizaon of sducabonal nstiuion Apple is atiing to grant You o iimfled
licenss 10 uss P NOM Cortificales an parmined hargin on the erms and condtions set forth in this

Agresment
1. A& this Agr
1.1 Accoptanco

In order 10 Usa he DM Ceaficales and related sanioss. You mwst frst agree 1o this Licnae Agrésment If
You go not of caonot agree to Pes Licenae Agresmaent, You sie not pemmtiod 10 use the MDH Cenficates o
retatnd sernces. Do nol downoad of use the MDM Cenficales or &by relalad sanicss in thal case

P | have read and agrees 1o these terms and conditions

Frimabis Version >

Uhe vl Ok Linew 10 - RU0- Y - APRLL v ae Agpn Barad Ll 1w e Aple e

gt & 201\ Sgpbe e AN sighes reewrsnd,  Terma af Use Piivan, o

-

fone May

Suppaort

LIE Foeiy Sommant s %

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile

Management Certificate Portal.

Apple Push Certificates Portal

Create a New Push Certificate

Upload your Cestificate Signing Request signed by your thind-party serves
vendor to create a new push certificate,

Siowse. |
b Bogls Onling Yece - M0-UV-APE srun or Apohe Mepdl Sacrep o0 Wl 4 remlies Apche inle e Vg et Newy 45 S Comstget é
Tt VT 2E1 ) Mpwle bor. A aghit reseerad  Tormes of Use Srivacy Paliey
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6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.

Select Download to download the Apple signed certificate.

-

Certificates for Third-Party Servers

Service Vendor Expiration Date™ Status Actions

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.

Learn more about MDM push certificate migration

Shop the Appla Onling Stora {1 -300~MY-APFLE), visit an Appls Retail Stors. or find a resaller. Appis tnfo Sita Map Hot Naws

Copyright © 2012 Appls Inc. All rights rdzarved.  Tarms of Uss Privacy Palicy

= Store Mac iPod iPhone iPad iTunes Support a

Apple Push Certificates Portal

Mobile Device Management  Novell Inc Jun 15,2013 Active m

-

R5S Faads Contact Uz E___E

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile

Management server.
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Completing the Certificate Request from IIS Manager 6

1. Return to the IIS Manager. Select Start > Control Panel > Administrative Tools > Internet
Information Services (lIS) Manager.

Right-click any Web site in the left panel. Select Properties.

3. Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

Select the Process the pending request and install the certificate option and click Next.

Browse to the aps_production_identity.pem file that was provided by Apple. Click Next.

1S Certificate Woard 1IS Certificate Wizard B=

C Process a Pending Request
P = 9 ficate Request y Process a pending certificate request by retrieving the file that contains ®
A penaing cenficate reguest £ 3 request 10 which the oerdfication the certification authority's response. §

authorty hess ol yel resporded

Enter the path and file name of the file containing the certification authority's response.

A cetficate rmquest s pendog. VWhat would you ke to do? Path and file name:

c:\aps_production_identity. per| Browse... I

(% Process the pending recuzat and install the cenifinate

" Dalete the panding requast

< Back I Nest > I Cancel I

6. On the Certificate Summary screen, verify that the certificate information is correct and click Next,
then click Finish.

7. Open the Microsoft Management Console (MMC). Click Start > Run and enter MMC.
8. From the File menu, select Add/Remove Snap-in.
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9. From the drop-down list at Snap-ins added to, select Console Root and click Add. On the Add
Standalone Snap-in screen, select Certificates, then click Add.

Standalone I Extensions I Available standalone snap-ins:

Snap-in | Vendar | -
@.NET Framework 1.1 Configuration  Microsoft Corporation
6E.ﬁ.ctive Directory Domains and Trusks  Microsoft Corporation
ﬁ.ﬁ.ctive Directary Sites and Services Microsaft Carporation
@Active Directory Users and Compu...  Microsoft Corporation

Use this page to add ar remove a stand-alone snap-in from the console.

Snap-ins added to: Ia Conscle Root j

afl.ﬁ.ctivex Control Microsoft Corporation
Authorization Manager Microsoft Corporation
g Certificate Templates Microsoft Corporation
LiFi ] Microsaft Carporation
@Certiﬁcation Autharity Microsoft Corporation
@Component Services Microsoft Corporation LI
=

i~ Description
The Certificates snap-in allows vou ta browse the contents af the
certificate stares for yourself, a service, or a computer.

~ Description

Add Close

Remayve About, |

QK | Cancel |

10. On the Certificates snap-in screen, select Computer account and click Next. Choose Local
computer and click Finish.

Certificates snap-in x|

Thiz =hap-in will always manage certificates for:

My uzer account

r
™ Service account
&

Computer account

Select Computer x|

Select the computer you want thiz znap-in ko manage.

— Thiz znhap-in will abways manage:

i+ LLocal computer: [the computer this consale is running onk

i~ ancther computer; I Browse,.. |

[ &llow the selected computer to be changed when launching from the command line. T his
only applies if pou zave the conzole.

11. Click Close. Click OK on the Add/Remove Snap-in screen.
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12. At the Console Root, expand the directory. Select Certificates > Personal > Certificates. Right-click
on the certificate file and select All Tasks > Export. This opens the Export Wizard. Click Next to
continue.

'{ii Console Root',Certificates {Local Computer)Personal'Certificates

[_3 Console Roat
E@ Certificates (Local Compr
E||:| Personal
a Certificates

27 Trusted Roaot Certific
|27 Enterprise Trust cuk | Expart...
(2 Intermediate Certific Copy
27 Trusted Publishers Delete
-2 Untrusted Certificate

7 Third-Party Root Cer Properties
123 Trusted People Help
7] Certificate Enrallmen
-0 sPC
JEN 4] |

| il

|C0ntains actions that can be performed on the ikem. |

13. Select Yes to export the private key, then click Next.

Certificate Export Wizard |

Export Private Key
You can choose ko export the private kew with the certificate,

Private keys are password protected, IF you wank ko export the private key with the
certificate, wou must type a password on a later page.,

Do wou wank o export the private key with the certificater?

% ¥es, export the private keyi

™ Mo, do not expart the private key
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14. Select the Personal Information Exchange — PKCS #12 (.PFX) format and select the Enable
strong protection box. Click Next.

Certificate Export Wizard x|

Export File Format
Certificates can be exported in a variety of file Formats,

Select the Format wou want ko use;
= DER encoded|binary: %509 (, CER)
" Base-64 encoded ¥.509 (, CER)
| Cryptographic Message Synbax Standard - FRES #7. Certificates (,E7E]

I™ | Include all certificates in bhe certification path if possible

i Personal Information Exchange - PKCS #12 (PR

[ Include all certificates in the certification path if possible
¥ Enable strong prokection (requires IE 5.0, WT 4.0 SP4 or above)

[ Delete the private kev if the export is successful

< Back I Mext = I Zancel

15. Enter and confirm a password. You will need this password when you upload the certificate to
ZENworks Mobile Management. Click Next.

Certificate Export Wizard B3

Password
To maintain security, you must protect the private key by using a passwaord,

Type and confirm a password.

Password:

Confirm password:

< Back l Mext = I Cancel
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16. Click the Browse button and select the .pfx file that you want to export. Click Next.
Certificate Export Wizard

File to Export
Specify the name of the file you want to-export

File name:

[C:\com.yourcompany.mdm.pfx Browse. .. I

< Back Cancel

17. Click Finish to complete the certificate export. You see a message that says the export was
successful.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the
following:

e APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Generating an APNs Certificate from Windows Server 2008 or 2012

The following instructions are for generating an APNSs certificate from Windows Server 2008 or 2012 by using
Internet Information Services (1IS) Manager version 7 or 8. You can skip this section if you use Windows
Server 2003. For Windows Server 2003, see Generating an APNs Certificate from Windows Server 2003.

Note: Appendix A provides instructions for an alternate method of generating the APNs certificate using

OpenSSL.

Creating the Certificate Signing Request (CSR) from IS Manager 7 or 8

1. Navigate to Administrative Tools and select Internet Information Services (1IS) Manager.

2. Select the server name in the left panel, then double-click the Server Certificates option in the
Security section of the menu.

”-'E Internet Information Services (IIS) Manager

GO (o —

File view Help

e.A' £ | l l&.
- %3 Start Page

=8 ﬁj

B b’ Application Pools
[#- @] Sites

Authentication CaI

U‘;l Home
Group by: Area x E: X
1IS

5%3; co1] 2]

Compression

Logging MIME Types Modules

Management
=, =]
5";‘5 =
Feature Shared

Delegation  Configuration

i -

=0 ) &
Directory Error Pages Handler
Browsing Mappings

D

€%y

Worker
Processes

3. From the Actions menu in the right panel, select Create Certificate Request. This starts the Request

Certificate Wizard.

Import...

Create Certificate Request...

Complete Certificate Request. ..

Create Domain Certificate. ..

Create Self-Signed Certificate. ..

‘@! Help
Online Help
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4. Enter the following in the Distinguished Name Properties window:

¢ Common name - Enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNs certificate. The Apple ID might be in the form of an email address, or

possibly a display name.

e Organization — The legal name of your organization

¢ Organization unit — The department within your organization

¢ City/locality — City in which your organization is located

o State/province — Abbreviation for the state or province in which your organization is located
e Country/region — Abbreviation for the country or region in which your organization is located

| Distinguished Name Properties

gl

Specify the reguired information For the certificate. Statef/province and Citw/locality must be specified

as aofficial names and they cannok contain abbreviations,

Cornmon name: IM\,.- ApplelD

Orgarization: INovell Inc

Organizational unit: IIT

Cityflocality IPrnvD

Skake/province: Il_ltah|

Countryregion: |I_|S j

Breviaus | Mext I Fimish

Zancel

5. Select Next.

6. Inthe Cryptographic Service Provider Properties window, accept the default setting, Microsoft RSA
SChannel Cryptographic Provider. In the Bit length field, select 2048 for the encryption level. Click

Next.
Reqguest Certificate

Cryptographic Service Provider Properties
'

3;;5

Select & cryptographic service provider and a bit Jength, The bt length of the encryption key

determines the certificate’s encryption strength. The greater the bit bangth, the stronger the securkty,

However, a greater tit length may decrease performance.

Cryptographic service provider:

{2048 ~|

Previous ” Next I

EIE3}

Cancel I
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7. Inthe File Name window, save the CSR to your computer. Record the location and filename. Click
Finish. This is the file you will upload to the ZENworks Mobile Management Certificate Request

Portal.

File Name

g

Specify the File name Faor the certificate request. This information can be sent ta a certification
authaority Far signing.

Specify a file name For the certificate request:

fcrapplemom sk, bxl |

Prewious Iesxk | Finish I Cancel
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated by using 1IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at:
https://zmmupdate.novell.com/apn

&7 Novell.

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

(Browse... |

Get Signed Request ]

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/ .
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2. Log in by using your Apple ID and password. This does not need to be an Apple Developer

account ID, but you should use an Apple ID that has been designated for managing the
corporate APNs certificate.

Apple Push Certificates Portal
Sign in.

ForQot your password?

rple Ovlire Stnre MY AT Apoke Betail Stve 3¢ S % reaslie Adstle ivde

Aout Al rgtes resmrewd . Taren =f Use Provery Pubey

3. Select Create a Certificate.

Apple Push Certificates Portal

Get Started

Create & push cartificate that enables your thard-party server 10 work with te Apple Push
Notification Service and your Apple devices

SAM MOore About Mobile Davice Managermmens
Whiat about QS X Server
Vi Aple Onling Pones () B30 NT ar we gt et Stase w0 Had 4 aealie . e !

wrves 2t Use Privacy Paliey
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4. Read the Terms of Use and accept the End User License Agreement.

iMhone W Support

Apple Push Certificates Portal S

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONDITIONS CAREFULLY BEFORE
DOWRLOADING DR USNG THE APPLE CERTIFICATE $, THE SE TERM S AND COMINTIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANYIORGANIZATION AND APFLE,

MOM Cavtficate Agteament
(Tor companies deploying modile davce 1or 105 g

Purpose

Your company, arganizatan or sducationsl Fvstitaion woukd I6e & use he MOR Catificates (35 detned
Baiow) 10 enstie You to ether deploy 2 Twrd-party Commercisl, scfarpose sanet software product fot mobile
device managemsnt of I0S pracucts, or deploy Your own intamal mobde devce managemaent for 08
protocts withi Yaur company, 01ganizaon of soucabonal nstiution Agple is atiing to grant You 8 hmiled
llcenss 10 uss P NOM Certificales an parmiBed harain on the s and condtions set forth in this

Agresment
1. A this Agr
1.1 Accoptanco

In order 10 uss he DM Cenficales and related saniose Yoy mwst frst agree 1o this Licsnae Agrésment If
You go not of caonot agree fo Pes Licenae Agrusment, You ae not permitiod 10 use the MO Cenficates o
retatnd sernces. Do not downoad of use the MOM Cenficales or &y relalad saricss in thal case :'

P | bave read and agree 1o these terms and conditions

Frimabis Version >

the A pyrle Ok Linws 1= AU aey - aPPLL o Agpn Batal Liwa 5 realing Spwle iy fane May - e NP Somsant Us §

winel Egpie miz AN righes resarand. Terme of Use Piivery fuoacy

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile
Management Certificate Portal.

Supporn

Apple Push Certificates Portal sear o con

Create a New Push Certificate

Upload your Certificate Signing Request signed by your thind-party serves
vendor to create a new push certificate,

Bowse. |
1he Boule Chaling Saet O 8301 H-APPLE sra on Apokt Metail Saden 5 Wl & revelies Aoche inle Une Mg bt Mawd 55 Feads Cmatamt 4 &;
g 8 Rt tor. Al it resesetd  Tormes of Use Sriaacy Paliey
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6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.

Select Download to download the Apple signed certificate.

-

Certificates for Third-Party Servers

Service Vendor Expiration Date™ Status Actions

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.

Learn more about MDM push certificate migration

Shop the Appla Onling Stora {1 -300~MY-APFLE), visit an Appls Retail Stors. or find a resaller. Appis tnfo Sita Map Hot Naws

Copyright © 2012 Appls Inc. All rights rdzarved.  Tarms of Uss Privacy Palicy

= Store Mac iPod iPhone iPad iTunes Support a

Apple Push Certificates Portal

Mobile Device Management  Novell Inc Jun 15,2013 Active m

-

P

RSS Faads Contact Us

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile

Management server.
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Completing the Certificate Request from IIS Manager 7 or 8

1. Return to Internet Information Services (lIS) Manager > Server Certificates and select Complete
Certificate Request from the Actions menu in the right panel. This starts the Complete Certificate

Request Wizard.

Import...

Create Certificate Request...
' Complete Certificate Request... '

Create Domain Certificate. ..

Create Self-Signed Certificate.. .

6' Help
Online Help

2. Browse to the aps_production_identity.pem file that was provided by Apple and enter a friendly hame.
This is simply a label you give the certificate to easily distinguish it. You might want to give it a name
in which your company is identified.

K E3

Complete Certificate Request

| ‘ Specify Certificate Authority Response
Complete a previously created certificate request by retrieving the file that contains the certificate
authority's response,

File name containing the certification authority's response;

IC: \aps_production_identity.pem o I

Friendly name:

|c0m.yourcompany .mdr|

oK I Cancel ]

3. Select OK to install the certificate to the server. You should see the certificate listed in the center
panel of Server Certificates.
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4. Export the certificate so that it can be uploaded to ZENworks Mobile Management. Right-click the
certificate you just installed and select Export.

"'!Elnternet Information Services {IIS) Manager H=]
o (% : | 1@ -
File  View Help
@ Server Certificates L. ..
&,' 3 I |& %' Import...
W5 Start Page: =
.8 Use this feature ko request and manage certificates that khe Web server can use with Web sites Create Certificate Request...
= = application Pools configured for S5L. Complete Certificate Request. ..
o/
- @) Sites Mame -~ | 1ssued 7o | tssuedey Create Domain Certificate. ..
COM, yourcompany. VIDM Apple Produckisstast o a
Create Self-Signed Certificate. ..
Create Certificate Request... Wiew...
Complete Certificate Request. .. Export...
Renew...
Create Domain Certificate:... ¢ raiove
Create Self-Signed Certificate... Q\ Help
View. .. Online Help
I Export, .. ]
Renew. ..
XK Remove
@\ Help
Online Help

5. Save the file to your Desktop in the .pfx format. You must set a password. You will need this
password when you upload the certificate to ZENworks Mobile Management.

Export Certificate EH

Export bo:

IC:Icum.ynurcnmpany.mdm.pfx v

Fasswiord:

Confirm password:

I I Cancel

You have successfully generated your APNs certificate.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the
following:

e APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Uploading the APNs Certificate to
ZENworks Mobile Management

This section explains how to upload the APNs certificate to ZENworks Mobile Management by using the
ZENworks Mobile Management dashboard. You need:

e APNSs certificate file (the .pfx format)

e The password you set when exporting the certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.
3. Click the Upload button next to the APNs Certificate field.

Apple Push Notifications X

Choose an APNs Certificate File: Browse...

Certificate Password:

Apple 1D:

Use Default URLs:

Server URL: \ ‘

Check in URL: \ ]

g., https: ServerAddress>/sync/iOSMDMSync.php

Click the Browse button, then navigate to and select the APNs certificate file (.pfx format).
In the Certificate Password field, enter the password you set when exporting the certificate.

6. Enter the Apple ID used to generate the certificate, if you want to display it for reference on the
Organization Settings page. This information can be useful at renewal time.

7. Check the Use Default URLs box to populate the Server URL and Check in URL fields with
https://<ServerAddress>/sync/iOSMDMSync.php. This is the required format of the URLs. Verify that
the <ServerAddress> is the external address of the ZENworks Mobile Management server.

Note: If you did not access the dashboard externally, do not use the default check box. Enter
the Server URL and Check in URLs manually, in the format noted above.
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8. Click the Submit button.

After you have uploaded an APNSs certificate, it appears under the APN Certificate field on the
dashboard in the format com.apple.mgmt.<random string> (Enabled)

APNs Certificate: Test Now

com.apple.mgmt.External.abfd343b-473d-497d-alce-a624dc606ac] (Enabled)

Note: The APNSs certificate must be renewed annually. The expiration date is displayed on
the Organization Settings page. You can also use the Test Now button to check the
certificate’s validity. The test will return the certificate’s activation and expiration dates.

9. Click Save Changes when you are finished.

Your ZENworks Mobile Management server is now able to trigger iOS devices with push notifications and
use the built-in Apple MDM protocol.

Updating the APNs Certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.

3. Click the Edit button next to the APNs Certificate field and make the needed changes. You can
change/disable/delete the APNs certificate or edit the password, Apple ID, or URLSs if necessary.

Apple Push Notifications X

Choose anaction: (3 Change APNs Certificate
() Disable APNs Certificate
() Delete APNs Certificate

Choose an APNs Certificate File: Browse...

Certificate Password:

Apple ID: \ |

Use Default URLs:  []

Server URL: Jhttps:.-’.v‘sslS.compani

g., https: ServerAddress>/sync/iOSMDMSync.php

Check in URL: Ihttps:,f'.v’sslS.c|ompanl

e.g., https://<ServerAddress>/sync/iOSMDMSync.php

Submit
4. Click the Submit button.
5. Click Save Changes when you are finished.

Tip: You might want to test APNs functionality after an update to the certificate by manually
updating the APN profile on a device. Open ZENworks Mobile Management on an iOS device
and tap Config > Load Configuration Profile. The device installs the initial profile and, after a
brief delay, it prompts for the user’'s Exchange password. If the prompt for Exchange credentials
does not occur, resetting 1IS might resolve issues preventing the APNs from processing.
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Applying an APNs Certificate to
Multiple Organizations

If you have System Administrator privileges, you can apply an existing APNs certificate to multiple
organizations on the ZENworks Mobile Management server.

For example, on-premise systems that have categorized various divisions of a company by creating multiple
organizations will allow those organizations to share one APNs certificate.

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.

3. Scroll down to the iOS Management section of the Organization Settings page. Click on the link
to the System Settings page under the APNs Certificate field. This option will not be available if
you are not logged in as a system administrator.

APNs Certificate: [ edit. | [ Test Now |

to apply an APNs Certificate to multiple organizations

You can also access System Settings directly by selecting System > System Administration >
System Settings.

4. On the System Settings page a list of organizations appears in the APNs Settings grid. If there is
an APNs certificate associated with the organization, the Apple ID, Expiration Date, and
Certificate Topic (certificate file) are listed beside it.

APNs Settings

Organization Name Apple ID Expiration Date Certificate Topic

Robin Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-0be2-243b095d35f7 |4

jmartin Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

cas cschuster@ex07.notify Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d357

Ninja

jbyers Aug 21 2015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

arivera Aug 21 2015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

Archana Aug 21 2015 5:46AM | com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

cmclemore Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7 |v|
[ Set Up l [ Enable ] [ Disable | [ Delete l [ Copy To I
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There are several functions you can perform from this grid.

o Set Up an APNSs certificate for the first time for one or multiple organizations
See also, Generating an APNs Certificate and Uploading the APNs Certificate.

¢ Renew an APNs certificate for one or multiple organizations (click Set Up)
See also, Renewing an APNs Certificate and Uploading the APNs Certificate.

o Disable/Enable or Delete an APNs certificate for one or multiple organizations

e Copy an existing APNSs certificate from one organization to one or multiple organizations (Copy To)
Caution:; Copying a certificate will overwrite any existing certificate associated with the organization(s)
selected.

To select multiple consecutive organizations in the grid, hold the SHIFT key and click on the first and last
organization.

To select multiple random organizations in the grid, hold the CTRL key and select organizations.

ZENworks Mobile Management 3.0.x Generating an APNs Certificate Applying an APNs Certificate to Multiple Organizations e 30



Renewing an APNs Certificate

The Apple Push Notification service (APNSs) certificate must be renewed annually. Organizations can keep
track of the certificate’s expiration date by setting an alert to occur prior to the date. The expiration date is also
displayed on the Organization Settings page.

To set the APNs Certificate Expiration alert:
e From the Organization page select Compliance Manager > Alert Settings > System Alerts.

e Enable the Apple Push Notification (APNs) Certificate Expiration alert and configure when you
want the reminder to begin and how often to be reminded. The default settings are to issue the
reminder 30 days prior to the expiration and repeat it every day.

e You can also choose to have an E-mail and/or SMS alert sent to an administrator.

el Alert Settings Enabled E-mail SMS

Alert Recipients
z » Access Restriction Based Alerts

Alert Settings
» 31 Device Platform Restrictions » Non-Access Restriction Based Alerts

User Exceptions » Event Based Alerts

Watch List v System Alerts

v Apple Push Notification (APNs) ™ ™M % @ ™M 2 )

Certificate Expiration

Reminder prior to expiration {Daysh: |30
Report Every {Daysh: (1

Follow the instructions below to renew the APNs certificate that was generated from the Apple Push
Certificates Portal or from Apple’s iOS Developer Enterprise Program (iDEP).

Essentially, you follow the same process used to obtain the original certificate. The only difference is in the
steps taken on the Apple Push Certificates Portal (Steps 4-6 below.)

To renew an APNSs certificate:

1. Create a new Certificate Signing Request (CSR) by using IS Manager (See the complete
instructions: [IS Manager 6 or IIS Manager 7/8)

2. Upload the CSR to Novell's ZENworks Mobile Management Certificate Request Portal. Click Get
Signed Request and save the signed request file. See the complete instructions.

3. Go to the Apple Push Certificates Portal at https://identity.apple.com/pushcert/ .

o If you originally obtained the certificate from the Apple Push Certificates Portal, log in with the

Apple ID you used to generate the certificate.

¢ If you originally obtained the certificate through iDEP, log in with the Apple ID for the iDEP
Agent account.
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4. On the page where your certificate is listed, click the Renew button next to the APNs certificate you

are renewing.

Apple Push Certificates Portal

Certificates for Third-Party Servers

Service Vendor Expiration Date™ Status Actions

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.

| boais Maokilo Oy Y

.‘ Store Mac iPod iPhone iPad iTunes Support a

Mobile Device Management  Novell Inc Jun 15, 2013 Active m

5. On the Renew Push Certificate page, click the Browse button and select the .request file (a .plist

format) to upload. Click Upload.

Apple Push Certificates Portal

Renew Push Certificate

imter your Certrhicate Lagmang Roguest vgned by your thud-garry server

ador 16 renaw the lalloewg puth coentdicate

Service Metwn Devew Managemeer

Ner b

Brcowne

6. The page where certificates are listed displays the certificate with a new expiration date. Click the
Download button next to the renewed certificate to download it and save it as a .pem file.

Use IIS to complete the CSR (See the complete instructions: IIS Manager 6 or IS Manager 7/8)

8. From the ZENworks Mobile Management server dashboard, upload the renewed certificate.

Select System > Organization.

Click the Edit button next to the APNs Certificate field and choose Change APNs Certificate.

(See complete instructions: Updating the APNs Certificate).
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Appendix A: Generating the APNs
Certificate Using OpenSSL

The following set of instructions can be used by those who do not want to use Internet Information Services
(IIS) Manager or those who need an alternate method. These steps should work on any platform on which
OpenSSL runs.

1.

2.

Install OpenSSL for Windows from http://slproweb.com/products/Win320penSSL.html.

From the command line, create the CSR and private key:

openssl reqg -out apns.csr -new -newkey rsa:2048 -nodes -keyout apns.key
Enter the specified information with the Common Name set to your iTunes account name.
Follow the APNs signing instructions in this document to get the signed certificate (MDM_Novell
Inc_Certificate.pem) from Apple.

a. Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal
b. Uploading the Intermediate Certificate to the Apple Push Certificates Portal

Merge the key and the certificate to a .pfx file:

openssl pkcsl2 -export -out apns.pfx -inkey apns.key -in MDM Novell
Inc Certificate.pem -certfile CACert.crt

Note: If a certfile does not exist, the last parameter of this command
(-certfile CACert.crt) can be dropped.

Specify the password to be used to protect the private key.

Upload the APNs certificate file (in .pfx file format) to the ZENworks Mobile Management console.
See Uploading the APNS Certificate to ZENworks Mobile Management, in this document.
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